
IDG Style Guide

Last Updated: February 1, 2002

The IDG Style Guide can help you to make style and design choices in your
documentation. Not every possible instance is covered, but the guidelines presented
here should help you in making a decision.

The PDF version of the Style Guide is also available. Also, you can get the Developer
Quick Guides for Writing API documentation, GUI documentation, and the Writer’s Quick
Guide for Writing GUI Documentation.

If you need more help, you can consult the Microsoft Manual of Style for Technical
Publications.

If you find anything missing, incorrect, or outdated, please create a Bug at
http://bugs.nextpage.int and assign it to IDG. Be sure to state what needs to be added or
changed, and what document you are referring to.

Conventions

Lowercase entries represent words as words (except in cases where the word must be
capitalized). These entries are also always singular. For example, the entry for "above"
is lowercase because it deals with using the word "above" in documentation.

On the other hand, uppercase entries deal with guidelines. These entries are also always
plural. For example, the entry for Punctuation Guidelines deals with some basic rules
for using punctuation in documentation.

So, the entry for makefile is lowercase and singular because it deals with using the word
"makefile" in documentation. There could also be an entry for Makefiles that dealt with
how to make and use makefiles to create content collections of your documentation.

As far as possible, given the above information, the appropriate style has been applied to
this Guide. If you find a discrepancy, report it to the person responsible for maintaining
the guide.
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Document Information and Copyright Notice

Document Name Version Date

IDG Style Guide 1.1 February 1, 2002

Copyright Notice

Information in this content collection is subject to change without notice and does not
represent a commitment on the part of NextPage, Inc. The software described in this
document is provided under a license agreement. The software may be used or copied
only in accordance with the terms of the license agreement. It is illegal to copy the
software on any medium except as specifically allowed in the license agreement. No
part of this manual or any other peripheral documents may be reproduced or transmitted
in any form or by any means, electronic or mechanical, including photocopying and
recording, for any purpose without the express written permission of NextPage, Inc.

NextPage, NXT, NextPage RapidApps, NextPage Application Framework, NAF,
LivePublish, and Folio are trademarks or licensed trademarks of NextPage, Inc. or its
subsidiaries. All other names are used for identification purposes only and may be
trademarks of their respective owners.

The following companies have licensed for inclusion in this software the technology
which is copyrighted by their respective companies:

Contains security software from RSA Data Security, Inc. Copyright© 1998 RSA Data
Security, Inc.

XML Parser, Copyright© 1999 The Apache Software Foundation

IBM Classes for Unicode, Copyright© 1999, International Business Machines
Corporation and others. All Rights Reserved.

Microsoft (R) is a registered trademark of Microsoft Corporation.

Published and printed in the USA.

Copyright© 2001 NextPage, Inc. All rights reserved.

NextPage, Inc.

3125 West Executive Park Way

Lehi, UT 84043

U.S.A.
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Acronyms
Note: Technically, an "acronym" is a pronounceable word, an "abbreviation" is a
shortened form of a word, and an "initialism" is an abbreviation formed from the initial
letters of words in a phrase, pronounced as individual letters (for example, "SDK"). In
this guide, "acronym" is used to refer to all of them.

Spell out acronyms on first use in each document or topic unless the acronym is widely
understood or spelling it out doesn’t say anything (for example, "Asynchronous Transfer
Mode (ATM)" doesn’t help anyone. Just use "ATM").

Common acronyms that do not need to be expanded can be found in the Common
Acronyms document.

Start with the spelled out version, then include the acronym in paretheses. However, in
document titles you can use acronyms without spelling them out first. You should spell
them out on the first use in the main text of the topic.

Plural acronyms are created by adding an "s" (no apostraphe). See Plurals.

Do not use the same abbreviation for two or more terms in the same document (for
example, do not use "ATM" to refer to the networking protocol and a machine where
you can get money).

Do not use more than one abbreviation for the same term in the same document (for
example, do not use "LN" and "LNotes"). Choose one and stick with it.

Do not apply wording that repeats the wording that has been abbreviated (for example,
don’t say ATM machine because the M stands for machine).

Correct
The Lotus Notes (LN) database.

See Also

Capitalization Guidelines

FAQ

GUI

Acronym Finder: a web site that lets you type in and search for acronyms and their defi-
nitions.

abort
Do not use "abort" except for technical documentation, where you can use it if referring to
a function name, parameter name, or part of a name in an API. Use "quit" for programs
and "end" for communications and network connections. Use "stop" for hardware
opertions. Use another appropriate word in other situations.

Correct
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To end your server connection, click Disconnect Network Drive on the Tools menu.

Quit all programs before you turn off your computer.

To stop a print job before it’s finished, click Cancel.

The PHW_CANCEL_SRB routine is called when the minidriver should cancel a request
with STATUS_CANCELLED.

See Also

end

quit

above
Do not use "above" to mean earlier in a book or online document; use "previous",
"preceding", "earlier", or something more specific instead. You can also use "earlier" to
refer to a chapter or section heading. Do not use "above" as an adjective preceding a
noun, as in "the above section".

See upper for information about directional usage.

To show a cross-reference to another Web page, use a specific HTML hyperlink. Do not
make assumptions about the user’s path through a site. Even if you refer to a location on
the same scrollable Web page, make the reference itself a link. Do not use "above".

Incorrect
You obtained these values in Step 2 above.

Correct
You obtained these values in Step 2.

See "Connecting to the Network," earlier in this chapter.

See Also

Cross References

Directional Terms

access key
The "access key" is the underlined letter of a menu command. Use this phrase only in
documentation about customizing the interface, otherwise just say "underlined letter".

Correct
To change the access key defined for a menu item, go to the Preferences menu.

Type the underlined letter of a menu option to select that option when using the keyboard.
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Active Voice Uses

Active voice is the preferred voice in documentation.

See Also

Active Voice vs. Passive Voice

Passive Voice Uses

Voice Guidelines

Active Voice vs. Passive Voice

Active voice is preferred in documentation because our documentation focuses on
providing steps for performing a task. This is inherently an "active" process.

See Also

Active Voice Uses

Passive Voice Uses

Voice Guidelines

affect vs. effect

"Affect" is the verb form and "effect" is the noun form.

Correct
Late software can affect a schedule adversely.

One effect of late software is schedule slippage.

Ampersand (&)

Do not use an ampersand (&) in place of the word "and".

and/or

Do not use this style. Rewrite to make clear and explicit. In many cases, you can just
use "or" because the meaning is understood.

Correct
You can save the document under its current name or under a new name.

Will the new version contain information both on how to write object-oriented code and
use the class libraries or just one?
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Apostrophes

See Plurals.

backup (noun), back up (verb)

Use "backup" when describing the concept or result, and "back up" when talking about
the process.

Correct:
Back up the files before you turn off the computer, and save the backup on a floppy disk.

below

See lower for information about directional usage.

See above for information about other usage.

Bold Uses

The word "bold" can be used as a noun, adjective, or verb.

Here are the elements that should be bolded in documentation:
• options
• field names/labels
• menu names
• menu options
• toolbar button names
• buttons
• desktop icon names

See Also

button

Document Conventions

Headings

menu item

Boolean

"Boolean" is always capitalized.

Boolean operators are in all caps (AND, OR).

See Also
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Logical Operators in Document Conventions

boot

See start or restart.

box

Use "field", not "box", except for "check box".

See Also

field

check box

Check box in Dialog Box Elements

browser

See Web browser.

See Also

Web

Builder

Do not use "Builder" to refer to the utility. Use "NextPage Application Framework Build
Utilities" or "NAF Build Utilities" instead.

Note: This name is changing, so stay tuned.

If you need to point to the documentation for NAF Build Utilities Help, just use text
directing the user to the "NextPage Application Framework Build Utilities Help file" since
the content collection may not be installed on the server.

See Also

Cross References

button

Use "the <ButtonName> button" around the button name if needed for clarity. Keep
"button" lowercase, as in "the Cancel button".

Bold button names, using the ButtonName tag.

Buttons may be dimmed or unavailable.
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When documenting buttons that use ellipses, don’t put the ellipses in the documentation.
Similarly, do not include and other punctuation used along with button name. For
example, do not include a ">" or "<" with the button name.

Incorrect
Click the Profiles >> button.

Click Options....

Click the Cancel field.

Correct
Click the Profiles button

Click Options.

Click the Cancel button.

See Also

Bold Uses

Command button in "Dialog Box Elements"

Unfold button in "Dialog Box Elements"

Document Conventions

OK

can vs. may
"Can": able to do something.

"May": show possibilities or an unknown result.

See Also

may vs. might

should

want vs. desire vs. wish
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cannot
One word. Use instead of "can’t".

See Also

Contractions

Capitalization Guidelines
Do NOT use capitalization for emphasis (this sentence is an example of how not to do
it). Use italics or quotation marks instead.

Do not capitalize the spelled out form of an acronym (unless a word is a proper noun).

Use book title capitalization for all headings and subheadings.

Use book title capitalization in referencing the following interface elements: menu
names, command and button names, toolbar buttons and toolbar names, dialog and
window titles, tab names.

Use sentence capitalization for the following: field names, table headings.

Some words are always capitalized or have capitalization that is important to follow:
Boolean, CD-ROM, FAQ, GUI, Internet, Net, NextPage, OK, Unix, Web, wizard (or
Wizard).

See Also

Document Conventions

File Extensions

Keyboard Keys

Readme Files

URLs

CD-ROM
Use "CD-ROM" when referring to the computer disk. Don’t spell out this acronym. Don’t
use "CD".

See Also

disc

cell phone
Use "cell phone" instead of "cellular phone" in documentation.
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Note: You may need to distinguish between cell phones and wireless phones.

check box

Two words.

Users "select" or "clear" check boxes (not "turn on" and "turn off", "mark" and "unmark",
"check" and "uncheck", or "select" and "deselect").

Also, use the identifier "check box", not just "box", to refer to this option, because "box"
alone is ambiguous for localizers.

Check boxes can also be dimmed, unavailable, and shaded.

Correct

The Animated text, ScreenTips, and Highlight check boxes are selected.

The Draft font and Picture placeholders check boxes have been cleared.

The Include non-HTML documents (documents without links) in cache check box is
unavailable. Because it is unavailable, the check box appears dimmed.
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The check boxes in the Check items to include in the domain area that are shaded
indicate that some, but not all, of the child content is selected.
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See Also

clear and select

Check box in "Dialog Box Elements".

Dialog Box Syntax Guidelines

Screen Terminology Guidelines
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choose vs. click
Users "choose" menu items.

They "click" everything else.

See Also

check box

clear and select

click

Dialog Box Syntax Guidelines

menu item

mouse

clear and select
Use these terms to refer to putting a checkmark inside a check box.

Don’t use "check" and "uncheck" or "mark" and "unmark".

See Also

check box

choose vs. click

click

Dialog Box Syntax Guidelines

dimmed

click
Use "click" rather than "choose" or "select" for everything except menu items.

Users "click" the button, not "click on" the button or "click at" the button. However, users
click in windows and text boxes.

Note: It is acceptable to omit the step "Click OK." at the end of a task if the interface
makes it clear that clicking the button is necessary to complete the procedure.

Use "double click" as a noun, and "double-click" as a verb.

If a user can set an option to use either a single click or a double click, use the default
mode when documenting a feature. But do explain the various options in Help and
in the user’s guide.

See Also
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choose vs. click

clear and select

Dialog Box Syntax Guidelines

mouse

close
Use "close" when referring to windows, documents, or dialogs.

abort

boot

end

start

quit

collapse
Use with "expand" for opening or closing a tree node.

Colons
Use a "colon" only when the preceeding phrase is a complete sentence.

Use an initial capital for the word that follows the colon in the following situations:
• The word following the colon is a proper noun.
• A quotation follows the colon.
• The colon is used prior to an ordered or unordered list.
• The text after the colon consists of more than one sentence (when the sentences are

directly related to the introductory phrase for the colon).

In all other cases, use lowercase.

Use periods instead of colons in figure or table introductions or captions.

See Also

Commas

Lists

Sentence Structure Suggestions

command prompt
Not "MS-DOS prompt" or "DOS prompt".
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Commas

"Commas" signal a small interruption in the sentence.

Use a comma with any of the following:
• With "which", but not with "that" clauses.

Correct

This is the document that I wrote. (Meaning here is the document, and it is important
to know that I wrote it).

This is the document, which I wrote. (Meaning here is a document, and oh, by the
way, I wrote it).

Incorrect

This is the document which I wrote.
• After most introductory phrases (the comma can sometimes be omitted with short

sentences).
• To separate items in a series of three of more items. Put a comma before the con-

junction when the conjunction precedes the final item.
• Between two main clauses (complete sentences) that are separated by a coordinating

conjunction ("and", "or", "but", "not", "nor", "for", "so", and "yet"). Notice that "then" is
not a coordinating conjunction. Add a coordinating conjunction, or use a semicolon,
to connect independent clauses with "then".

See Also

Colons

Sentence Structure Suggestions

that vs. which

then

computer

Not "PC", "machine", or "box".

Contractions

Avoid using contractions in documentation.

See Also

cannot
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cookie
Always lowercase (unless it starts a sentence).

Cross References
Generally, cross references will be to other content collections, Web sites, or topics
within the current content collection. In these cases, the part that is the link is not stylized
in any special way aside from the style created by the Link tag.

Use quotation marks around cross references to sections or chapters in other works
when the text is not a link.

Use italics for references to entire works when the words are not a link.

See Also

Builder

Document Conventions

Italics

Links

Quotation Marks

URL

Dashes
Since the m-dash and n-dash do not translate well to HTML, use two dashes when you
want to represent either of these typographical symbols.

Avoid using a dash to set off a parenthetical phrase (use commas or parentheses instead)
or in a list where the first word is being defined (use a comma, period, or colon instead).

Incorrect
The program--a new one from NextPage--is very useful.

Build--the process of making a content collection.

Correct
The program, a new one from NextPage, is very useful.

Build: the process of making a content collection.

See Also

Colons

Commas
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Hyphens

Lists

data

"Data" travels over, not through.

Never pluralize to "datum".

demo

No need to spell out to "demonstration". Use "demo’d", "demoing", and "show a demo",
but not "to demo".

desire

See want vs. desire vs. wish.

desktop

Lowercase.

Dialog Box Elements

In most documentation, especially for end users, do not differentiate between elements
such as drop-down lists, combo boxes, and so on. Everything is basically a field.

In general, do not use the name of the particular element in documentation except in
reference to designing interfaces. However, use the terms "check box", "tab", or "slider"
after their respective elements. Use lowercase for the name of the element ("the Spaces
check box"). Use sentence caps for the specific field label, but follow the interface (for
example, "the Show only indexed attachments option button").

"Button" and "option button" are also okay to use if the context warrants the need to be
more specific.

Use "unavailable" if an option is not able to be selected (commonly referred to as
"grayed out").

The following table describes the various elements that can appear in dialog boxes:
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Element
Name

Definition Usage Example

Check box Square box that is
selected or cleared
to turn on or off an
option. More than
one check box can
be selected.

Check boxes
can also be
dimmed, shaded,
or unavailable.

Select the Spaces
check box.

Click to clear
the Bookmarks
check box.

Select the
appropriate check
boxes.

Command
button
(referred to
as "button",
if at all)

Rectangular button
that initiates an
action.

A command button
label ending with
ellipses indicates
that another dialog
box will appear:
More information
is needed before
the action can be
completed.

Click Options.

Click the Cancel
button.

Drop-down
arrow

Arrow associated
with a drop-down
list or some toolbar
buttons, indicating
a list the user can
view by clicking the
arrow.

Click the Size
arrow to see more
options.
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Drop-down
list

Closed version of a
list box with an arrow
next to it. Clicking
the arrow opens the
list.

In the Item
drop-down list,
click Desktop.

Group box Frame or box that
encloses a set of
related options. It is
a visual device only.

Under Effects,
click Small Caps.

In the Effects
area, click Small
Caps.

Label Text attached to
any option, box,
command, and so
on. Refer to any
option, box, and so
on by its label.

In the Font field,
click Arial.

List Any type of box
containing a list
of items the user
can choose. The
user cannot type a
selection in a list
box.

In the Wallpaper
field, choose
the background
wallpaper of your
choice.

Option
button

Round button used
to select one of a
group of mutually
exclusive options.

Click Portrait.
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Slider Indicator on a gauge
that displays and
sets a value from a
continuous range,
such as speed,
brightness, or
volume.

Move the Volume
slider to the right
to increase the
volume.

Spin box Text box with up and
down arrows that
the user clicks to
move through a set
of fixed values. The
user can also type
a valid value in the
box.

In the Date field,
type or select
the part of the
date you want to
change.

Tab Labeled group of
options used for
many similar kinds
of settings.

On the Tools
menu, click
Options, and then
click the View tab.

Text box Rectangular box in
which the user can
type text. If the box
already contains
text, the user can
select that default
text or delete it and
type new text.

In the Size field,
select 10 or type a
new font size.

In the Size field,
enter a font size.
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Title Title of the dialog
box. It usually,
but not always,
matches the title of
the command name.

In the Options
dialog box, click
the View tab.

Unfold
button

Command button
with two "greater
than" signs (>>)
that enlarges
a secondary
window to reveal
more options or
information.

Click Profiles for
more information.

See Also

button

check box

Dialog Box Syntax Guidelines

dialog vs. dialog box

dimmed

drop-down list

field

group box

label

Lists

option button

shaded

slider

tab

text box

unavailable

window
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Dialog Box Syntax Guidelines

"Click": Use for commands, command buttons, option buttons, and options in a list,
gallery, or palette.

"Select" and "clear": Use for check boxes.

"Type or choose": Use to refer to an item (as in a list box) that the user can either type
or choose in the accompanying text box.

Except for the identifiers "field", "button", "check box", and "tab", the generic name of
an item within a dialog box (list, option, and so on) should not follow the item’s label,
especially within procedures. "Check box" in particular helps localizers differentiate
this item from other option boxes.

Use bold for field labels, button labels, tab labels, and options.

See Also

choose vs. click

clear and select

click

close

collapse

Dialog Box Elements

drag

enter

enter vs. type

expand

mouse

Screen Terminology Guidelines

dialog versus dialog box

Use "dialog box".

Refer to the dialog box by its title when necessary, especially if the user needs to go
to a new tab.

Correct
In the Options dialog box, click the View tab.
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See Also

Title in "Dialog Box Elements"

Dialog Box Syntax Guidelines

dialup (adjective), dial (verb)
Do not add "up" to the verb form.

dimmed
Use "dimmed" or "appears dimmed" (not "grayed") to describe the appearance of a
command or option that is unavailable.

See Also

check box

shaded

Directional Terms
Hyphenate directional terms when they are used as adjectives.

See Also

left

right

upper

lower

disc
Use this spelling when referring to a CD or CD-ROM.

In general, do not use "disc" in possessive constructions.

disc

disk
In general, use this spelling of "disk" to refer to both hard disks and floppy disks. Do
not use "diskette".

Unless necessary, use just "disk", not "hard disk", "floppy disk", or "3.5-inch disk". Do not
use fractions or symbols when specifying a disk; use decimals and spell out inch.
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In general, do not use "disk" in possessive constructions, such as "disk’s contents" or
"disk’s name"; instead, use "disk contents" or "disk name".

disc

Document Conventions

Consistent use of typographic conventions in documentation helps users locate and
interpret information easily. The following guidelines present some specific typographic
conventions:

Item Convention Example

Accessory programs Title caps Heap Walker

Nmake

Notepad

Acronyms All uppercase (unless
standardized differently)

CUA

FIFO

modem

Attributes Bold; capitalization varies IfOutputPrecision

Book titles Title caps, italic. Use the
BookReference tag.

See the Visual Basic Custom
Control Reference.

Chapter titles Title caps, in quotation marks See Chapter 9, "Extending
Forms".

Code samples,
including keywords
and variables within
text and as separate
paragraphs, and
user-defined program
elements within text

Monospace, using the
CodeInText or CodeSample
tags

#include <iostream.h>

void main ()

the pointer psz

Command-line
commands and options
(switches)

All lowercase, bold. Use
the CommandParameter or
CommandOption tag.

copy command

/a parameter
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Commands on menus
and buttons

Bold; capitalization follows
interface (usually title
caps). Use the MenuName,
MenuOption, or ButtonName
tag.

Date and Time

Apply

New Query button

Dialog box options Bold; capitalization follows
interface. Use the FieldName,
OptionName, and TabName
tags.

Click Close all programs
and log on as a different
user?

Find Entire Cells Only check
box

Dialog box titles Title caps. Use the
WindowTitle tag.

Protect Document dialog box

Import/Export Setup dialog
box

Directories Initial caps (internal caps are
acceptable for readability).
Use the FileName tag.

\\Irstaxforms\Public\\IRSTax
Forms\Public

Extensions Match file extension case
in system (for Windows, it’s
okay to just use lowercase)

.mdb

.doc

File names Match file name case in
system (for Windows, it’s
okay to use initial caps
or to use internal caps to
aid readability). Use the
FileName tag.

My Taxes for 1995

Msacc20.ini

MSAcc20.ini

Icon names Bold; title caps Recycle Bin

In the Control Panel window,
click Add New Hardware.

Key names, key
combinations, and
key sequences

Initial caps. Use the
KeyboardKey tag.

Ctrl+Tab

Shift, F7

Alt, F, O
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Logical operators All uppercase AND

XOR

Menu names Bold; title caps. Use
MenuName.

Insert menu

Emphasis or terms
used in a different
way than the reader
is accustomed (if the
word appears in the
glossary, simply do a
GlossaryLink instead)

Italic You must close the window
before you exit.

You may think of the items in
a database as records.

This is the build or index
phase.

Words used as words Quotation marks Do not use an ampersand to
represent the word "and".

Use "back up" to refer to the
process of making a backup.

Placeholders (in syntax
and in user input)

Use a beginning and ending
angle bracket (< and >)
around the placeholder

<InstallPath>\Templates\Enu
directory

Type <password>

http://<YourS-
erver>/NXT/gate-
way.dll?f=tem-
plates$fn=<YourDefault-
Page.htm>

Toolbar button names Usually title caps (follow
the interface); bold. Use
ButtonName.

Format Painter

Insert Microsoft Excel
Worksheet

URLs Match case; break long
URLs after a forward slash, if
necessary; do not hyphenate.
The protocol name can be
omitted when telling someone
to connect. Leave off end
slahes, but code into links.

http://www.microsoft.com

seattle.sidewalk.com

/music

www.microsoft.com

Windows, named Title caps. Use WindowTitle. Help window
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Windows, unnamed All lowercase. Do not use
WindowTitle.

document window

Values Quotation marks ???

Constants Use CodeInText ???

See Also

Bold Uses

Capitalization Guidelines

Italics

New Meanings for Exising Terms

Quotation Marks

download

One word.

drag

Use "drag" instead of "click and drag". For beginners, use "press and hold the mouse
button".

See Also

click

mouse

drop-down list

Use "drop-down list", not just "drop-down".

Drop-down lists may be dimmed or unavailable.

Differentiate between versions that allow users to enter text as well as select from the list
in the explanation of the task, using "type or choose", or something similar.

Correct

In the Item drop-down list, choose Desktop.
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Type or choose a value for Notes field to use as title for document.
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See Also

choose vs. click

Drop-down list in "Dialog Box Elements"

effect

See affect vs. effect.

eg.

Don’t use.

29



Use "for example" instead.

either/or

Do not use. Fill out the construction.

Correct
You can either close the document or quit the program.

end

Use "end" to refer to communications and network connections.

See Also

abort

close

quit

email

Use "email", not "e-mail" or "E-mail".

Emphasis Guidelines

See document conventions for a list of common components of documentation and
the emphasis convention used.

See bold, italics, quotation marks, and capitalization for the specific type of emphasis.

ensure vs. insure

"Ensure" means "to make certain" or "guarantee". Do not confuse with "insure", which
refers to insurance, or "assure", which implies giving positive information.

enter

Use "enter" only when referring to the keyboard key that a user should press. Do not use
to mean that the user should type something into a field or area.

See Also

enter vs. type

Keyboard Keys
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enter vs. type
Do not use "enter" as a synonym for "type".

Use "type", not "type in". If a user can either type an option or select one in a list (in a
combo box, for example), use a combination of words such as "type or select".

Incorrect
Enter your answer in the Answer field.

Type in your answer in the Answer field.

Correct
Press Enter after you type your name.

Type your answer in the Answer field.

In the Font field, type or select the font you want to use.

etc.
Do not use.

Use "and so forth" instead.

expand
Use with "collapse" for opening or closing a tree node.

FAQ
Can spell out this acronym if you want, but it is not usually necessary.

If pronounced "fack", precede with a, when pronounced as letters, use an.

See Also

Acronyms

Plurals

fax
Use "fax" instead of "facsimile".

field
Use "field" instead of "box" when referring to an interface element.

Put "field" (or "list", "check box", "tab", and so forth) after the name of the object.

See Also
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button

check box

Dialog Box Elements

Dialog Box Syntax Guidelines

Document Conventions

group box

menu item

option button

slider

spin box

tab

File Extensions

When used on the end of a file name, match the case used in the operating system.

When used in general when talking about a file type, use all caps and no period.

Correct
executive.ini

DLL files

The XSL is in your Templates directory.

file name

Two words.

frame vs. pane vs. area

Use "area" to refer to a "frame" or "pane" unless you are specifically talking about the
creation of a frameset and frame pages.

functionality

Only use this word occasionally. Better to say "its functions" or "its features".

Graphics

When used in text to explain a concept, graphics should be described in detail in the text
(assume that the user cannot see the graphic). Don’t expect the graphic to speak for
itself. Graphics are meant to supplement the text, not to replace it.
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grayed

See dimmed.

group box

Two words, lowercase. A "group box" is a standard control used to group a set of options
in a dialog box. For example, page ranges are grouped in the Page range group box
in the Print dialog box in Word.

A group box may be dimmed or unavailable.

The term is acceptable in programmer documentation. Avoid in end-user documentation.
To save space, it’s generally unnecessary to include the name of the group box in
procedures unless options with the same label appear in more than one group box. If
necessary for clarity, you can use either "under <Group box label>", or "in the <Groub
box label> area".

Correct
Under Effects, click the Hidden check box.

In the Effects area, click the Small Caps check box.

See Also

Group box in "Dialog Box Elements"

GUI

All caps. Plural is "GUIs".

See Also

Acronyms

Plurals

handheld

One word.
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Headings

Titles should be discernable out of context (from a search results list).

Don’t refer to the heading in the first sentence (don’t make the heading part of the first
sentence).

Avoid making single subheadings (in other words, you should normally have two or more
subheadings under a heading).

The hierarchy of headings, from most important to least, is as follows:
• Title
• HeadingNoTOC
• SecondHeadingNoTOC
• EmphasisBoldItalic
• EmphasisItalic
• BodyText and no additional styling on the heading

Headings for tasks and examples must start with a gerund (a gerund ends in "ing"). All
other headings may not begin with a gerund. For example: Adding a Content Collection
to a Site.

Examples headings start with a gerund and end with the word "Example". For example:
Creating a Site from Scratch Example.

Screenshot headings start with the name of the window or dialog box, followed by
"Properties" if it is a properties dialog box, then a comma and the name of the tab
followed by the word "Tab", and finally the word "Screenshot". For example, "Create New
User Screenshot" or "Lotus Notes Service Properties, Forms Tab Screenshot".

high tech

No hyphen.

homepage

One word.

hotspot

One word. It is used to refer to the part of an imagemap or screenshot that is clickable.
But, avoid using in end user documentation.

Hyphens

Avoid hyphenating nouns: email, homepage, etc. are correct.

Hypenate adjectives.
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Avoid hyphenating between a short prefix and a word, even with adjectives. Examples of
short prefixes are "un" and "non".

icon

Use only to describe a graphic representation of an object that a user can select and
open, such as a drive, disk, folder, document, or program.

When referring to a program icon, use bold for the icon name: "Click the Word icon."
Within programs, do not use "icon" for graphical dialog box options or options that appear
on ribbons, toolbars, toolboxes, or other areas of a window.

In general, use the most descriptive term available, such as "button", "field", "check box",
"tool", and so on. If an option has no visual properties except its graphic nature, use
"symbol", as in "warning symbol."

i.e.

Do not use.

Use "in other words"or "that is" instead.

Never use IE to refer to Internet Explorer, always spell out the product name.

imagemap

Do not use to refer to a graphic, unless specifically talking about the HTML process of
tagging an image for clickable regions. See screenshot vs. screengrab.

in order to vs. to

Use "to" instead of "in order to".

Incorrect

Select the option in order to sound a bell

Correct

Select the option to sound a bell

indexsheet

One word.

insure

See ensure vs. insure.
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Internet

Capitalized unless referring to generic network of connected networks. Preceed with
"the" unless it’s being used as a modifier.

irregardless

Don’t use "irregardless", irregardless of your intentions. It is redundant. Simply use
"regardless".

Italics

Italicize book titles (unless also a link) and cross-references. Use quotation marks
instead if it’s a shorter work, like an article in a magazine or chapter of a book. Use
the BookReference tag.

Italicize foreign words, and use any appropriate accents or diacritics.

Use italics for emphasis and for terms used in an unconventional way.

Correct

Site Design Help

"Tasks" in Site Design Help

JPEG, JPG

Graphics formats. Both extensions are correct. JPG is more common for Windows-based
machines.

Officially, JPEG is used as the acronym for either the group that created the standard, or
the standard itself.

Keyboard Keys

Initial cap the key name, with no additional styling. Use the KeyboardKey tag to mark
the key name. If documenting key combinations or sequences, tag each individual key
rather than the included plus sign (+) or comma (,).

Users "press" a key, they don’t "hit" a key.

Key combinations

Use a plus sign (+) between keys, with no spaces around the plus sign: SHIFT+ALT+F1.

Key Sequences

Use commas (,), followed by spaces to indicate that the user should press and release a
sequence of keys: ALT, F, D means press and release ALT, then F, and then D.
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keyword

One word.

label

Do not refer to "label" in documentation. Do not use "caption" either. Simply refer to the
label as the name of a field, button, check box, and so on.

Correct

The Stylesheet name field.
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See Also

field

Label in "Dialog Box Elements"

left

Use "left" instead of "left-hand" when referring to a location. Can also use "leftmost",
"upper left", "lower left", and so forth.

Hyphenate the term when used as an adjective, as in "upper-left corner of the page".

Links

Links are important for online information.

Never create a link around "click here" or similar words. Put the link on meaningful words.

In a step, you should generally link to the Reference topic instead of the Concept topic.

Put Concept links either in the beginning paragraph (the explanation of the steps), in a
note, or in the See Also section. Put other links in the See Also list as well, even those
that appear elsewhere on the page (this makes them easier to find).

Lists

Avoid making a list that only has one item.

Use a bulleted list to set apart items when the sequence is not important. If order is
important or if you need to refer to a specific list item, use a numbered list. Use the
parameter list for definitions or in reference topics.

Make the list items parallel in sentence structure and part of speech.

Capitalize the first word of each item in the list, and either end each item with a period or
no punctuation. Use a period if at least one of the list items is a complete sentence.

Arrange lists in a meaningful way. As a last resort, arrange alphabetically. If the
arrangement is not obvious, include an explanation.

Do not use a list to complete a sentence. The phrase that introduces a list must be a
complete sentence. This aids translation and makes the meaning more obvious.

For the interface, a list should be referred to as a field.

See Also

List in "Dialog Box Elements"
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log on, log off

Use "log on" or "log off" as verbs, and "logon" or "logoff" as adjectives.

Don’t use "to" with it (for example, "log onto").

login

The account used to log on.

look and feel

Do not use in documentation.

lower

Use "lower" instead of "below" when referring to a location. Can also use "lowest", "lower
right", "lower left", and so forth.

Hyphenate the term when used as an adjective, as in "lower-left corner of the page".

makefile

One word.

may vs. might

Use "may" to denote permission, use "might" to denote possibility. Usually, you will use
"might" instead of "may" in documentation.

See Also

can vs. may

should

want vs. desire vs. wish

Measurements

For computer capacity, use "GB", "KB", and "MB" (no need to spell out the acronyms).

For speed, use "KBps" for "kilobytes per second" and "Kbps" for "kilobits per second"
(you may need to spell out the acronym depending on your audience).

Other than these, avoid using measurements unnecessarily in documentation.
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Use numerals for all measurements, even if the number is under 10 or the unit of
measure is spelled out or not. Measurements include distance, temperature, volume,
size, weight, points, and picas, but generally not units of time.

Abbreviations of units of measure are the same whether the number is one or more (1
in., 2 in.).

When units of measure are not abbreviated, use the singular unit for quantities of one or
less, except for with zero, which takes the plural form (0 inches).

Abbreviations of measurements appear without periods, except for the abbreviation
for "inch", which always takes a period.

Insert a space between the number and the unit.

media

"media": the press.

"mass media": any means of communication.

"medium": physical material to store data. "Media" is the plural form.

menubar

One word.

menu item

Use "command" instead of "menu item", "option", or "choice" if you must specify the
menu item as some thing.

Use "click" to refer the process of navigating and selecting menu items.

Correct

On the Edit menu, click Copy.

On the Edit menu, point to Options, and then click General.

The following graphic shows some menus and terminology.
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Users click menus, click commands on the menu, select dialog box options, and click
command buttons in dialog boxes.
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Don’t use the possessive form of menu or command names.

message

Use "message" instead of "alert", "error message", "message box", or "prompts" ("error
message" is okay in technical documentation when describing types of messages).

meta tag

Two words.

metadata

One word.

monitor

Use "screen" instead of "monitor".

mouse

Plural is "mice".

Use "pointer" instead of "mouse cursor".

In general use "point to" instead of "move the mouse pointer to".

If documenting mouse and keyboard, describe the mouse method first, then another
method if appropriate.

Use "mouseclick", "mousepad", "mouseover", etc. and pluralize the second half of the
compound (for example, "mousepads" is correct and "micepads" is not).

See Also

click

n

Conventionally, a lowercase italic n refers to a generic use of a number. You can use
n when the value of a number is arbitrary or immaterial.

Contrast with x

Net

Although we prefer "Internet", this is an acceptable shortening. Capitalize unless
referring to a generic internet.
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network

Do not use as a verb.

A computer is "on a network". Computers are "linked" or "connected" (not "networked").

New Meanings for Existing Terms

Use italics when using a term in a way that is different from the conventional usage.

Non-Breaking Spaces

Use a non-breaking space between NXT and the version number: NXT 3.

This doesn’t always work right in Epic, but when it does, you can press Ctrl+Space to
acheive the desired effect. Otherwise, you can either use the text entity called "space"
that does this, or use the "platform" entity if you are specifically talking about a version of
the NXT platform.

Notes

The title of a note should always be "Note". Use the NoteTitle tag.

Notes (including cautions, important notes, tips, and warnings, as well as general notes)
call the user’s attention to information of special importance or information that can’t
otherwise be suitably presented in the main text.

Use notes sparingly so that they remain effective attention-getters. One per help topic is
best. If two are adjoining, combine into one. Use no more than two adjacent notes.

Nouns

Avoid stacking nouns (long noun strings). Break up noun strings into no more than 3,
or possibly 4, nouns, if possible.

Numbers

Spell out numbers zero through nine (unless used with a unit of measure). Numbers
10 and above are written numerically except if one starts a sentence or it appears
side-by-side with another number (spell out one of the two).

Hyphenate compound numbers like "twenty-one".

Do not use numeric and spelled out form of the same number (for example, "five (5)
screws" would be incorrect usage).
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OK

Use all caps for button name.

Use "okay" otherwise.

Don’t use "the" and "button" around "OK" in a step.

on

Use "on" with the following elements:

• Desktop

• Disk

• Hardware platform

• Interface

• Menu

• Network

• Screen

• Taskbar

• Toolbar

online, offline

One word each.

onscreen

One word.

option button

Use "option button" instead of "radio button"

You do not have to use "option button" after the label name.

Option buttons can be dimmed or unavailable.

See Also

Option button in "Dialog Box Elements"

44



Passive Voice Uses

Use passive voice to emphasize the object being acted upon or to deflect criticism from
the reader (for example, "You should not have pushed that button" may be too harsh.
Instead, you could use, "That button should not be pushed").

Passive is also approriate when it is clear that the system performs an action or when an
action occurs that the user cannot control.

See Also

Active Voice Uses

Active Voice vs. Passive Voice

Voice Guidelines

PDA

Avoid this. Use "handheld" or "palm pc".

Phone Numbers

Begin with the plus sign (+) then the country code, use parentheses for the area code,
and do not use hyphens or other punctuation elsewhere in the phone number.

An exception to the use of the plus sign (+) is toll free numbers that only work in the U.S.:
you would simply write it as (800) 769 4733).

Correct

+1 (801) 768 7834

plaintext

One word.

platform

Lowercase, one word.

plug-in

Always hyphenated.
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Plurals

The standards for making words plural are as follows:

• acronyms: use the acronym + s

• single letter: letter + ’ + s

• number: number + s

•

Do not use "(s)" after a word to indicate plural possibilities. Use either the plural form or
"one or more".

See Also

Acronyms

pop-up

Hyphenated. Do not use as a noun and avoid using as a verb (that leaves adjective
usage).

Used to refer to the result of a user mousing over something and having some text
appear in a "hover balloon". Different than ToolTips (which would just show one or
two words about a button or command).

Possessives

Do not use the possessive form for acronyms or for inanimate objects.

power

Use "turn on" or "turn off" rather than "power up" or "power down" or "shut down".

Prepositions

It is okay to end a sentence with a preposition to prevent awkward constructions.

Avoid stacking prepositions.

pulldown

One word.
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Punctuation Guidelines

When using quotation marks, you should usually leave commas and periods inside the
closing quotation mark unless the quotation marks are being used to show an exact
phrase that a user must type.

Avoid using dashes in documentation.

See Also

Apostrophes

Colons

Commas

Hyphens

Quick Guides

See Writing Guides.

quit

Use "quit" when referring to programs.

See Also

abort

close

end

Quotation Marks

Not "quote marks" or "quotes".

Use around sections or chapters of a longer work, or around shorter works when doing
a cross-reference.

When using quotation marks, you should usually leave commas and periods inside the
closing quotation mark unless the quotation marks are being used to show an exact
phrase that a user must type.

See Also
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Punctuation Guidelines

radio button

See option button.

Readme Files

Typed as "Readme", with the initial letter capitalized and as one word.

read-only

Adjective, hyphenated.

refresh

Use "refresh" to refer to updating a Web page. Avoid using in documentation to describe
the action of an image being restored on the screen or data being updated; instead, use
"redraw" or "update". To refer to the Refresh command, use language such as: "To
update the screen, click Refresh."

restart

Use "restart" instead of "reboot".

See Also

Start

right

Use "right" instead of "right-hand" when referring to a location. You can also use
"rightmost", "upper right", "lower right", and so forth.

Hyphenate the term when used as an adjective, as in "upper-right corner of the page".

screenshot vs. screengrab

Use "screenshot". One word.

Create them within the context of the book file for the project (if you do it outside, you’ll
have a big headache to deal with).
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Screen Terminology Guidelines

The following graphics show various screen elements and the terminology that you
should use to describe them.
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See Also

Dialog Box Elements

Dialog Box Syntax Guidelines

Document Conventions

Sentence Structure Suggestions

Keep sentence structures simple. Avoid creating sentences that contain more than
one or two clauses.

Sexist Language No-No’s

Do not use "he/she".

Use "he or she", "you", or rewrite to not include the pronoun.

Avoid gender-specific terminology in general, like "police man" or "councilman" (try
"police officer" or "council member").
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Shaded

Use "shaded" for mixture of settings check boxes.

See Also

check box

dimmed

should

You should avoid using "should" in documentation because it can be ambiguous.

Instead, change your sentence in one of the following ways:

• Make the sentence imperative. For example, "Quit all programs and shut down the
computer."

• Use "must" to tell users that they are required to perform some action.

• Use a phrase such as "we recommend" or "NextPage recommends" or "it is recom-
mended".

• Rephrase the sentence to recommend some action or condition.

See Also

may vs. might

site map

Two words.

slider

A slider is an interface control that a user can drag left or right, or up or down to increase
or decrease a field value.

A slider may be dimmed or unavailable.

Correct

Move the Volume slider to the right to increase the volume.
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See Also

Slider in "Dialog Box Elements"

spin box

A "spin box" is an interface control that lets users increment or decrement a field’s value.

You should not use "spin box" in documentation. It is merely a field.

A spin box may be dimmed or unavailable.

Correct

In the Start field, type or select the time you want.

See Also

Spin box in "Dialog Box Elements"

stand-alone

Hyphenated.

start

Use "start" instead of "launch" or "boot".

See Also

restart

Steps

Keep steps in tasks short. Usually, a task should only have around 7 or fewer steps. If it
is longer, consider breaking the task into several sub-tasks.

For tasks that include instructions for navigating through more than one tab on a dialog
box, create a headings for each tab section and restart numbering.
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An example of this can be found in DOCS Open. Please note that the links do not work
as this file has merely been copied to a directory that this style guide can easily reference.

style sheet

Development has traditionally used two words, so we have also used two words in our
documentation so that it matches.

However, we would prefer it to be one word to match the rest of the industry. We are
working on getting this changed.

submenu

Describes the secondary menu that appears when the user selects a command that
includes a small arrow on the right. Avoid in end-user documentation if possible, for
example, by referring only to what appears on the screen. The term is acceptable
in programmer documentation.

sync

Not "synch" or "synk" or "sink".

tab

Do not use as a verb. Because multiple uses can be ambiguous, especially for
localization, use the noun "tab" alone to refer only to a tab in a dialog box. For other uses,
clarify the meaning with a descriptor: the Tab key, a tab stop, or a tab mark on the ruler.

Always use "the <TabName> tab" when describing this interface element. And bold
the tab name.

Correct

On the Tools menu, click Options, and then click the View tab.
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See Also

Tab in "Dialog Box Elements"

Tables

Place a table as close as possible to the principle reference to it.

A table usually has column headings (use the TableHeading tag) and may or may not
have a title. Introduce tables with a sentence ending with a period. If a table is titled, an
introductory sentence does not have to immediately precede the table.

If the table is titled, use title caps for the title. That is, do not capitalize articles (a, an,
the), prepositions of four or fewer letters, or coordinate conjunctions. Capitalize only the
first word of each column heading, the first word of each column entry, and proper nouns.

Note: You can use lowercase for the first word in column entries if capitalization might
cause confusion: for example, a column of keywords that must be lowercase.

End each entry with a period if all entries are complete sentences or are a mixture
of fragments and sentences. An exception is when all entries are short imperative
sentences (only a few words); these entries do not need a period. If all entries are
fragments, do not end them with periods.
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table of contents

Do not use "Table of Contents" as the heading for the list of contents at the beginning
of a document or file; use just "Contents" instead. It is correct to refer generically to
the table of contents, however.

text box

Use "field" to refer to the area where the user can type text. It is acceptable to use
"area" if the text box uses multiple lines.

You can use the term "text box" in documentation about creating HTML forms.

A text box may be dimmed or unavailable.

Correct

In the Size field, enter a font size.

See Also

field

Text box in "Dialog Box Elements"

that vs. which

In general, if you use "which", you need to precede it with a comma. "That" is not
preceded by a comma.

Specifically, "which" introduces a nonrestrictive clause. Because it is nonrestrictive, it is
secondary to the meaning of the main clause. For example:

• The computers, which have two monitors, are for developers.

• The computers that have two monitors are for developers.

In the first sentence, the computers are for developers and all have two monitors. In the
second sentence, some computers have two monitors and some do not. Only the ones
with two are for the developers.

See Also
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Commas

third-party

Hyphenated.

Time Guidelines

Use "a.m." or "p.m.", with a space between the time and the "a.m." or "p.m." designation.

then

Use "and then" rather than just "then".

Use "then" with a semicolon or another coordinating conjuction.

toolbar

One word, lowercase.

toward

"Toward", not "towards".

Translation Issues

To make translation easier, follow these guidelines:

• Eliminate guesswork for translators.

• Present information in ways other than alphabetical (since the order will no longer be
alphabetical when translated).

• Allow room for expansion (in tables, etc.). Generally, you should expect up to 25%
expansion.

• Use humor sparingly, if at all.

• Avoid culture-specific terminology, slang, American jargon, idioms because they
make translation difficult.

The Jargon Dictionary

Dictionary of Regional American English

American Business Language Dictionary
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• Avoid ambiguous words: because, compromise, regular, alternate, quite, eventually,
while, so, may, once.

• Limit sentences, especially steps, to one instruction.

• Write in active voice.

• Be consistent with terminology.

• Avoid using Latin terms (e.g., etc., and others).

• Use direct sentences written in Subject-Verb-Object order.

unavailable

Use "unavailable" if an option is not usable because it appears dimmed.

Use "make unavailable" instead of "disable".

Unix

Initial capped.

upper

Use "upper" instead of "above" when referring to a location. Can also use "uppermost",
"upper right", "upper left", and so forth.

Hyphenate the term when used as an adjective, as in "upper-left corner of the page".

URLs

Just create the link, no additional styling is needed. However, you should use BoldLink
for links to Field explanations in the Reference section.

However, if you use BoldLink, the link will not change to the visited color after a user
clicks on it. To get around this, you can use the regular Link tag and put the FieldName
tag inside that.

Match the case of the site style for path names.

You do not need to put "http://" in front. However, if the protocol is not "http", then you
must include it (for example, "https", "ftp").

Break long URLs after a punctuation mark, and don’t add in a hyphen.
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user

Avoid using "end user" in documentation. Just use "user".

user name

Two words.

utilize

Do not use. Use "use" or another appropriate synonym instead.

Version Numbers

The word "version" is written in lowercase, and there is a space before and after
the version numbers. They are written in the form <Major Version>.<Release
Version>-<Modification Version>, withe the release and modification versions being
optional. For example:

NXT 3 version 3.2

Updates to documentation add a hyphen and ordinal number to show successive
updates to a version. For example, 3.2-1 and 3.2-2.

See Also

"Revisions" in the IDG Process Document

versus and vs.

In headings, use the abbreviation "vs.", all lowercase. In text, spell out as "versus".

via

"Via" implies a geographic context. Avoid using "via" as a synonym for "by", "through", or
"by means of". Use the most specific term instead.

Voice Guidelines

Avoid passive voice. Use active voice, especially in notes or tasks where the reader
must do something.
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Active Voice Uses

Active Voice vs. Passive Voice

Passive Voice Uses

want vs. desire vs. wish

Use "want" instead of "desire" or "wish".

See Also

can vs. may

may vs. might

should

Web

Capitalize when used as noun, lowercase when used as adjective.

Correct

the Web

a webmaster

a Web browser (because the noun is "Web browser" and not just "browser")

a Web site (or possibly "a web site", depending on if you are differentiating between a
"brick and morter site" and a "web site")

Web browser

Use "Web browser" instead of "browser" alone or "Internet browser".

See Also

Web
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whether vs. whether or not

Use "whether" when users can make a choice between options.

Use "whether or not" if only a binary choice is given.

Correct

Select whether you want rain, snow, or ice.

Decide whether or not you want to create a backup.

wildcard

One word.

On first use in each topic, say "wildcard character", and then use "wildcard" after that.

window

Title cap window names.

Refer to the window by its title when necessary.

See Also

Title in "Dialog Box Elements"

wish

See want vs. desire vs. wish.

wizard

Always use lowercase for the generic term "wizard". Capitalize "Wizard" if it is part of a
feature name that appears in the interface.

Writing Guides

This style guide provides all the guidelines that you need to create a quality document.
However, since this document is quite large, and since you are not required to commit all
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the rules to memory, you can use the one-page Quick Guides for Writing to refresh your
memory on several of the more useful and oft-used guidelines.

The writing guides are as follows:
• Developer Quick Guide for Writing API documentation
• Developer Quick Guide for Writing GUI documentation
• Writer’s Quick Guide for Writing GUI Documentation

x

A lowercase italic x is used as a placeholder number or variable. Do not use it to refer to
a generic unspecified number; use n instead.

yo-yo

Do not use to refer to users.

However, you are welcome to play with one on your break.

zero

Plural is "zeros", not "zeroes".

In measurements, when the unit of measurement is not abbreviated, "zero" takes the
plural, as in "0 megabytes".

See Also

Measurements

Numbers
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